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VERSION 2.0 UPDATE VERSION 2.0 UPDATE VERSION 2.0 UPDATE

CHAMP has been updated to version 2.0, to include the following:

Capability to model the 0.2% annual chance event (500-year) has been added
to CHAMP. New inputs for the 500-year event include wave height, wave
period, and wave setup. Erosion for the 500-year event is based on a dune
reservoir of 1,030 square feet.

Added a user option under the Transect menu to round all station numbers to
the whole foot. Once this function is executed the decimal numbers can not be
recovered. Also all tables will now display the entire station number without
rounding. This is useful when detailed topographic data such as LIDAR data is
used to extract ground profiles and may have numbers out to multiple decimal
places. For long transects this may present a problem because the WHAFIS
program only allows for 6 spaces for the station number including the decimal
point. Any station number greater than 9999 does not allow the use of any
decimal places.

The option to input different wind speeds for the OF, IF, and VH cards other
than the default has been added to CHAMP under the General parameters tab.
If these fields are left blank the defaults are used. For the 100-year winds the
defaults are: OF=80mph; IF=60mph; VH=60mph. For the 500-year winds the
defaults are: OF=100mph; IF=75mph; VH=75mph.

Corrected the calculation of the dune eroded volume when a dune retreat case
is encountered. (Previous versions incorrectly calculate the dune reservoir
area.) Also fields were added to the Erosion program to show the value of the
total eroded area and the eroded area above the stillwater.

An error message will now display when the eroded profile slope does not
intersect the ground profile.

CHAMP will now automatically insert points in the profile where the total
stillwater intersects the ground profile when the WHAFIS table is populated.
Note that the inserted points are only made based on the starting total
stillwater elevation input into the General Parameters tab. If a change of total
stillwater is made along the profile such as a reduction to a backbay stillwater
or reduction of wave setup new ground intersection points will need to be
inserted.

CHAMP will now remove duplicate station points when the WHAFIS table is
populated. Duplicate stations in the WHAFIS model causes the WHAFIS model
to crash.

The starting total stillwater values that are populated on the IE card of WHAFIS
can no longer be changed from the WHAFIS table. They can only be edited
under the General Parameters tab. This avoids confusion of where to edit the
values and maintains consistency within CHAMP.
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VERSION 2.0 UPDATE VERSION 2.0 UPDATE VERSION 2.0 UPDATE

e The spelling text for two marsh grass (VH card) region types have been revised
to match the spelling in the FEMA Coastal Guidelines and Specification
documents. “Mid Atlantic” has been revised to be “Mid-Atlantic” and “North
East Gulf Mexico” has been revised to “Northeastern Gulf”.

e WHAFIS now has the capability to record comment lines in the input file as
well as the output file. This feature for input has been added to CHAMP in the
WHAFTIS table for input of the CM comment line and the PS comment line.

e The WHAFIS 4.0 help file has been added under the CHAMP help menu.

o The 2% wave runup value will now be calculated by CHAMP and displayed next
to the average runup value in the RUNUP program.

e The CHAMP internal MS Access database has been upgraded to work with
Access versions up to Access 2003.
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VERSION 2.0 UPDATE VERSION 2.0 UPDATE VERSION 2.0 UPDATE




VERSION 1.1 UPDATE VERSION 1.1 UPDATE VERSION 1.1 UPDATE

CHAMP update to version 1.1, included the following:

Previously, CHAMP automatically inserted into WHAFIS a default Marsh Grass
(MG) base stem diameter as measured in feet. This introduced an error in
WHAFIS that needed to be corrected. WHAFIS requires that the base stem
diameter be measured in inches. This CHAMP revision enables the user to use
the WHAFIS program default values unless more specific information is
available.

IMPORTANT NOTE: Existing users of CHAMP will need to modify their existing
Version 1.0 databases by reselecting each individual MG Card and reselecting
the plant type from the drop - down menu. This action is necessary in order
to change previously entered plant parameter values to zeros which will enable
WHAFIS to use program-provided default values.

Previously, CHAMP could not be run on the Microsoft Windows® ME operating
system. This CHAMP revision can be used on IBM-compatible PCs with the
Microsoft Windows® ME operation system in addition to the Microsoft
Windows® 95/98/NT/2000 operating systems.

Erosion assessments in CHAMP are currently performed for dunes with a crest
above the 1% annual chance (100-year) stillwater elevation (SWEL). With this
CHAMP revision, the user can now perform erosion assessments (removal case)
for ground profiles which are below the 1% annual chance SWEL.

Within the WHAFIS module, new station-elevation pairs had to be manually
inserted at the intersection with the 1% annual chance SWEL. In this CHAMP
revision, there is now a function that automatically adds station-elevation pairs
to the WHAFIS input profile where the ground profile intersects the SWEL.

This function will simplify WHAFIS model carding.

Previously, CHAMP enabled the WHAFIS program to simulate flood hazards for
transects which extended in distance to only four digits (i.e. 9,999 ft). By only
populating the WHAFIS program input file with station values to the whole foot
increment, CHAMP Version 1.1 now has the ability to simulate flood hazards
for transects which extend in distance to five digits (i.e. 99,999 ft) in order to
better accommodate LIDAR datasets.

VERSION 1.1 UPDATE VERSION 1.1 UPDATE VERSION 1.1 UPDATE
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Chapter 1: Introduction

1.1 What is the Coastal Hazard Analysis Modeling Program (CHAMP)?

Since the 1970s, the Federal Emergency Management Agency (FEMA) has routinely
established and updated standard methodologies for performing coastal hazard
assessments of fine scale wave phenomena associated with hurricane storm surges or
northeaster flooding effects. These methodologies include storm-induced erosion
treatments, wave height analyses, and wave runup analyses. The storm-induced
erosion treatment adopted by FEMA in 1988 is a schematic treatment of expected
erosion quantities and geometries; this treatment is performed manually by engineers.
There are two existing FEMA computer programs for wave height analysis: the 1989
Wave Height Analysis for Flood Insurance Studies (WHAFIS 3.0) program and the 1991
wave runup analysis (RUNUP 2.0) program. Both are DOS-based versions. The
WHAFIS 3.0 program has been updated in 2007 to WHAFIS 4.0 to include the wave
height modeling for the 0.2 % annual chance event. CHAMP now also includes a mode
to model the 0.2% annual chance event. These analyses establish the wave crest
elevation (SWEL plus wave height) and wave runup elevation (SWEL plus wave runup
height) at each representative transect along the coast.

Historically, these coastal hazard assessments (erosion, wave height and wave runup)
had to be performed separately for each transect, and there was no graphical interface
through which an engineer could collectively review the results obtained from these
assessments. Combining the results of the individual assessments into a per transect
graphic display of the respective flood hazard zones and Base (1% annual chance)
Flood Elevations (BFEs) (the wave envelope) was typically plotted by hand or done with
a spreadsheet. Often, changing a single input parameter can mean that all three
assessments must be re-run, and the results replotted. This process is cumbersome
and time-consuming. As part of FEMA’s map modernization efforts, this process has
been updated.

CHAMP is a Windows-interfaced Visual Basic language program that allows the user
to enter data, perform coastal engineering analyses, visualize and tabulate results, and
chart summary information for each transect within a user-friendly graphical
interface. With CHAMP, the user can import digital elevation data; perform storm-
induced erosion treatments, wave height analyses, and wave runup analyses; plot
summary graphics of the results; and create summary tables and reports in a single
environment.

With this User’s Manual, we are releasing Version 2.0 of CHAMP for use by FEMA
offices, study contractors, and coastal engineering firms. Please be advised that this
User’s Manual has been formatted and developed for direct application with this
CHAMP Version 2.0 release and is, therefore, subject to some changes and limitations.
These limitations include:

e CHAMP is designed to be used only on IBM-compatible PCs with either
Microsoft Windows 95, 98, NT, ME, 2000, or XP operating systems.

e CHAMP should be applied only to the Atlantic Ocean, Caribbean Sea, and Gulf
of Mexico coastal regions for coastal flood hazard assessments relative to the
National Flood Insurance Program.
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e Existing WHAFIS and RUNUP input files cannot be imported directly into
CHAMP. Data associated with these files need to be reentered into the initial
Data Entry Program and respective model applications.

o CHAMP follows a “linear” orientation of coastal analyses. Any editing or
addition/deletion of data is not automatically saved in the preceding programs.

e Automated mapping features associated with the CHAMP software have not
been fully developed. The graphics can be saved as a .dxf file for use with other
CADD or GIS applications.

CHAMP is composed of six programs, each of which includes a main operational
component to perform coastal flood hazard assessments and to identify flood zones.
These six programs include:

e Program 1: Transect Description/Parameter Entry

e Program 2: Transect Data Entry and Editing

e Program 3: Erosion Treatment (if applicable)

e Program 4: Wave Height Analysis

e Program 5: Wave Runup Analysis

e Program 6: Summary Tables and Graphics for Mapping
These programs appear on the CHAMP Main Menu Button Bar as follows:

Program 1: Program 2:
i Program 3: Program 4:
Transect Description/ Transect Data Entry . . .
- Erosion Treatment Wave Height Analysis
Parameter Entry and Editing

Coasta! Hazard Analyziz Modeling Program

File  Transect
e W a
F e Cpen General Tranzect | Emozion WHAFIS  Runup Eraphu:s T ablez

A

Program 6:
Summary Tables
and Graphics

Program 5:
Wave Runup Analysis

The flowchart on the following page outlines the general operating procedures for
running CHAMP. Detailed instructions and flowcharts for setting up and running
CHAMP and its six operational programs are included in Chapter 3 (Running CHAMP)
and Chapter 4 (Program Operation).
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PROGRAM 1
Transect
Description/
Parameter Entry

Enter project
Information

Select Transect

Enter transect
description
information

Enter detailed
transect
parameters

Open New or
Existing Project

PROGRAM 2

Entry & Editing

Enter transect
data—station,
elevation, and
source data

Create adjusted
transect data

!

I ) Transect Data
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
p

Select to model the
1% or 0.2% annual
chance event in the
main project window

!

T Compute eroded profile

General Operating Procedure for Running CHAMP

START
PROGRAM 3 PROGRAM 4
—————P Erosion -——> Wave Height
Treatment Analvsis

WHAFIS data
input table

Determine

Erosion graphic
editor

transect
segmentation
and enter

Compute dune
reservoir based on
selection of points

based on selection of

4 and/or Wave Runup
treatment is necessary,

Program 3

If transect data and profile
already eroded or erosion is
not applicable, proceed to
Wave Height Analysis Program

Analysis Program 5. If erosion

proceed to Erosion Treatment

points and balance

between eroded and
deposited areas (for
retreat only)

Create and display output

recnired data

SWEL changes

WHAFIS input
summary table

Run WHAFIS

View WHAFIS
output in

tabula}r and N
graphic form
and edit if

necessary

Create eroded
profile data

PROGRAM 5
Eim— Wave Runup
Analvsis

RUNUP data
input table

Determine
profile
segmentation
and enter
reanired data

Run RUNUP

View RUNUP
output in
tabular and
graphic form
and edit if
necessary

PROGRAM 6
Summary
Tables and
Graphics for
Mapping

Determine
information to
include in final
summary graphics

or tables

Transect input

Adjusted
transect input

Eroded profile
modeling

WHAFIS
modeling

RUNUP
modeling
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1.2

How To Use this User’s Manual

This User’s Manual contains the instructions and specifications needed to run CHAMP
successfully. Prior to running CHAMP for the first time, users should:

Have a good understanding of FEMA'’s coastal flood hazard mapping program
and the procedures for updating and revising a Flood Insurance Study (FIS)
and FIRM;

Have a good understanding of and demonstrated expertise in coastal
engineering analyses, including storm-induced erosion, storm surge flooding,
wave height generation and attenuation, wave runup, and wave overtopping.
The theory and procedures for these analyses are detailed in the Guidelines and
Specifications for Flood hazard Mapping Partners — Appendix D: Guidance for
Coastal Flooding Analyses and Mapping (April 2003) as well as in any
subsequent updates or procedure memorandums; these documents will be
referred to as G&S throughout this User’s Manual;

Be familiar with the functions and assumptions of FEMA’s WHAFIS 4.0 and
RUNUP 2.0 programs, and their respective user manuals;

Be familiar with the Microsoft Windows 95/98 /NT/ME/2000/XP environment;
and

Be familiar with the operation of a CADD program.

This manual takes the user through the program using many illustrations of the
various menus, input screens, and results screens. After reading the manual, the
user should be ready to start using the program. Throughout the manual, the user is
asked to select items from pull-down menus or click on objects. Unless otherwise
noted, the user should left-click to select an item.

The text of certain CHAMP operational features has been enhanced to help the user.
Enhanced text features include:

[Main Menu Button Bar Icons | are placed in a box and in bold;

|Commar1d Buttons| are placed in a box and not bold;

Text Fields and pull-down menu items are underlined; and

Windows are in bold.

1.3 Acknowledgments

CHAMP was designed and developed by Dewberry & Davis LLC for FEMA.
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Chapter 2: Installing CHAMP

CHAMP is a program written in Visual BASIC. This chapter contains the following
sections:

e Program Specifications
e System Requirements

e Installation Procedures

2.1 Program Specifications

CHAMP is a stand-alone, menu-driven Microsoft Windows-based program written in
Visual BASIC. CHAMP can be downloaded from the FEMA web site, which includes
the program, utilities, data components, user’s manual and the G&S.

2.2 System Requirements

The minimum requirements for installing and running CHAMP include:

e IBM-compatible PC (a 100 mHz or higher processor is recommended)

e Microsoft Windows 95, 98, ME, NT, 2000, or XP Operating System

2.3 Installation Procedures

CHAMP Version 2.0 is an update to the existing CHAMP Version 1.2. Instructions are
provided below for both CHAMP ‘Current Users’ and New Users’.

Current Users

Existing users should follow the instructions below to update CHAMP:

1. Copy the ‘champ.exe’ and ‘users.pdf’ files from the CHAMP Version 2.0 CD or
from http://www.fema.gov/plan/prevent/fhm/dl champ.shtm to a local
directory where CHAMP files are presently installed on your computer (i.e.,
C:\Program Files\CHAMP). These files should replace the existing ‘champ.exe
and ‘users.pdf’ files presently in this directory.

>

2. Double-click on ‘champ.exe’ to operate CHAMP Version 2.0.

3. Select About in the Help drop-down menu to see if ‘Version 2.0’ has been
correctly installed.

New Users

New users should access http://www.fema.gov/plan/prevent/fhm/dl champ.shtm
and follow the instructions under ‘Download CHAMP Version 2.0’ to install CHAMP.
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General Information

CHAMP should not be installed on a network drive as running CHAMP from a network
may cause it to run improperly.

If a question comes up asking if a file should be replaced by a newer version, the user
needs to make sure that replacing the older file will not affect the operation of another
program. Also, CHAMP may not run properly if the user keeps older versions of the
files to be replaced. Users should consult with their system administrator if they are
unsure.

NOTE: Sample data are provided in the “Samples” folder, which is accessible by
clicking on the Main Menu Button Bar.
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Chapter 3: Running CHAMP

This chapter outlines the program capabilities of CHAMP. It describes the following
components of CHAMP:

e File Organization
e Main Menu Button Bar Description

e Getting Started
3.1 File Organization

To organize general project information and transect data, CHAMP generates one .mdb
file (MS Access database file). To maintain data integrity, the user is limited to read-
only access to the .mdb file. Transect data files for WHAFIS and RUNUP are stored in
a subfolder with the same name as the .mdb file. WHAFIS data and output file names
begin with the prefix “W” followed by the name assigned to the transect. For example,
transect 3 in CHAMP will have input and output files named W3.dat and W3.out,
respectively. RUNUP files follow the same syntax except the prefix is “R.” For the
0.2% annual chance modeling the file name will be followed with a “n” as in “W10n.”
WHAFIS and RUNUP file names are relatively short because both programs operate on
a DOS platform, which accepts file names of no more than eight characters. Each
time WHAFIS or RUNUP is executed, the output files are overwritten.

The following example is for a project named “Simple Coast,” with two transects,
stored in the root X directory:

Directory Name Type

X:\ Simple Coast.mdb MS Access Database
Simple Coast)\ File Folder

X:\Simple Coast)\ R1l.dat/R1ln.dat DAT File
R1l.out/R1N.out OUT File
R2.dat/R2n.dat DAT File
R2.out/R2n.out OUT File
Wl.dat/Wln.dat DAT File
Wl.out/Wln.out OUT File
W2.dat/W2n.dat DAT File
W2.out/W2n.out OUT File
1.dxf/1n.dxf Graphic file
2.dxf/2n.dxf Graphic file

To avoid overwriting an existing project file, it is recommended that the user create a
unique folder name (which should not be changed) for each project or that the user
store the files on a CD-ROM.
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3.2 Main Menu Button Bar Description

After opening CHAMP, and then clicking Start on the initial splash screen, the Main
Menu window including the Main Menu Button Bar will appear. The Main Menu
Button Bar, shown below, is the main graphical interface of CHAMP and allows the
user to access the programs in a logical sequence.

Main Button Bar

f_jll Coastal Hazard Analysiz Modeling Program
File Transect Program Help Summary of

I & W 2 ¢ W | analyses for
Mew Open General Tranzect | Emogioh WHAFIS Runup | Graphicz  Tables selected transect
A N J

_éelectea

B transect Selected
= = information transect = I = -
Create a new data Analyses and modeling of
project or open an selected transect

existing project

3.3 Getting Started

To load an existing project or create a new project, and enter all necessary data, the
following seven steps must be performed.

Enter project information:
Step 1. Create a new project, or load an existing project.
Step 2. Enter general project information—select a transect for data
entry/editing.

Enter transect information:

Step 3. Enter/edit general information for the selected transect.

Step 4. Enter station and elevation data for the selected transect.

Step 5. Adjust transect reference station to zero elevation; this is
required to create necessary data tables for input to erosion
analyses and wave modeling.

Step 6. Return to main project window and repeat steps 3 through 5 for
each additional transect.

Step 7. Go to Erosion Assessment, WHAFIS, RUNUP for analyses and
modeling of selected transect.

These seven steps are detailed in Chapter 4 and in the flowchart titled “Project and
Transect Data Entry Procedures” at the end of section 4.2. Before the Erosion
Assessment, WHAFIS, RUNUP, and Summary Programs can be accessed, all of the
information for Program 1: Transect Description/Parameter Entry and Program 2:
Transect Data Entry and Editing must be completed. After entering the initial transect
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data in Programs 1 and 2, other elements in Programs 3 through 6 can be utilized by
clicking on the respective buttons.
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Chapter 4: Program Operation

This chapter provides an overview of the transect data set up, coastal engineering
analysis and modeling, and summary graphical display components of CHAMP. There
are two programs for the transect data setup, three programs that make up the
analysis portion, and a final program to display summary tables and graphs:

e Program 1: General Transect Description and Parameter Entry

e Program 2: Transect Data Entry and Editing

e Program 3: Erosion Treatment (if applicable)

e Program 4: Wave Height Analysis

e Program 5: Wave Runup Analysis

e Program 6: Summary Tables and Graphics for Mapping
4.1 Program 1: General Transect Description and Parameters

1. Load a Project

To create a new project:

a. Click on the Main Menu Button Bar (or choose New Project from the
File drop-down menu).
Select/create the folder to store the CHAMP files.

c. Enter the File Name, which will create a .mdb file, and data folder with the
same name and click Save.

To open an existing project:

a. Click |OPEN on the Main Menu Button Bar (or choose Open Project from
the File drop-down menu).
Go to the folder containing the .mdb file for the project.

c. Select and open the .mdb file.

Existing projects created in previous versions of CHAMP can also be opened
using this new version. CHAMP will convert the file to the newer version
format. Be sure to back up the older CHAMP version project files before
opening in the new version to prevent any accidental data loss.

2. To import multiple transect data:

a. Choose Import Data from the File drop-down menu. The following window
will appear:
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Es Import Wizard - Step 1 E

I Browser |
I Yertical D atum: I VI
Frojection: I VI
Modeler Mame: I =
Tranzect Unit Sypstem:® IEngIlsh vl

Froject Database:™

Project Title:

Community Mame: E stimated FIFM 5cale: | 'I

Clietit Mame:

Cancel | R |

b. STEP 1: Click on the BROWSER) button to select a file name and location
for the new project. Then fill in the appropriate project information. Click
on to move on.

c. STEP 2: Select the button to select the file where the transect
data are located. The files that can be imported are standard comma-
delimited text files (.csv), MS Excel (.xls), dBASE (.dbf), and MS Access
(.mdb) that contain transect numbers and station/elevation pairs. If
databases or spreadsheets contain multiple tables or worksheets, select
the data table or worksheet with the transect data you wish to import. All
data must be in one data table or worksheet. Only one data table or
worksheet can be imported. Select the data type, and then select the data
field that contains that particular data type. If you are not sure what is
contained in the data fields, a display of the first few rows of the data is
shown. Transect, Station, and Elevation are the only required fields. The
source field is not required to import data.

The data file with the transect information needs to be arranged as shown
below in order for the data to import properly. One column or field needs

X, Microaodt Fxcel - tost wls

e U Yew bt Fomet Tock Dets Wede bl =18l x|
DEE &RAY LHF T v A& LI DL - 5
Argl 0B sy EERESX, 43 EE _-5-A-
F17 = -
A B 3 o E F g H ! i
1 1 0 B =
2 1 F.1] 0
3 1 1] 15
4 1 0 1
5 1 =1] 12
] 1 B0 16
T 1 %0 18
8 1 110 18
] 1 130 17
10 1 140 17
1 1 150 16
12 1 170 .1}
13 2 0 0
14 2 10 5
15 E 1} 2
16 40 E 1] |
18 70 bz}
19 (3] M
2 100 N
21 120 0
2 180 F.]
3 150 i
24 F 160 i
= -
4 4 » B Sheett 1] |
Ry FM ;

to have the transect numbers that each station/elevation pair is related to.
That is, each data point must have an associated transect number. There
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must also not be any blank rows separating transects or data points and
no text title rows.

x
Select Data Source:
I Browse
Select Data Table:
Select Data Fields:
" Transect
" Station
" Elewation
" Source
[ Transect ID | |
E3| | J
Cear | [ ok |

Once all the appropriate data are selected, click the @ button to import the
transect data and create the project.

3. Enter General Project Information

£’ Coastal Hazard Analysis Modeling Program

File Transect Program Help

o6 D | & oS @ B |
Mew Open General Transect | Erosion WHAFIS Runup | Graphics Tables Tranzect |D: :" O 100y & S00pr

Project Database:” | Yertical Datum: MNGYD 29 -
Project Title: |Samp|e Data Projection: Lat/Long -
Modeler Name: |quhn Doe Transect Unit Systerm:®  |English -
Cammurity Hame: |anstal Tawn USA Estimated FIRM Scale:  |17=500° =

Client M arme: |FEM.-’-‘« Mumber of Transects:* |T |dpdate

After loading the project, the main Project Information window will appear. These
fields will be used in the WHAFIS and RUNUP programs for the title block. The path
and name of the .mdb file are visible in the Project Database field; however, the user
cannot modify this field.

e Project Title: User-specified to sufficiently identify the project site.
e Modeler Name: Self-explanatory.

e Community Name: Name of community to which this analysis is being applied.
Should be the same as the community name on the FIRM.

e C(Client Name: Self-explanatory.
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e Vertical Datum: All project data should reference the same vertical datum
used for the FIRM. Currently, the user has only two choices for vertical datum.
These are the North American Vertical Datum of 1988 (NAVD 88) and the
National Geodetic Vertical Datum of 1929 (NGVD 29). This field, as well as the
Projection and Estimated FIRM Scale fields, will be used for automated
mapping, which will be developed in future versions of CHAMP.

e Projection: Same requirements apply as for vertical datum. The choices are
currently Latitude/Longitude, State Plane, and Universal Transverse Mercator,
also known as UTM.

o Transect Unit System: English (feet) or Metric (meters).

e Estimated FIRM Scale: Anticipated scale of the FIRM to be created. Current
options include (1 inch = x feet) 400, 500, 800, 1,000, and 2,000.

e Number of Transects: This field establishes the number of transect files that
will be opened for data entry. The user can increase the number of transects
at any time.

After entering/editing data, click on the pull down menu in the upper right hand
corner of the window labeled Transect ID to select a transect. To run the Erosion
Treatment, Wave Height Analysis, and Wave Runup Computation programs in
CHAMP, the user must first create and/or select a transect to be analyzed.

To add, delete, or rename a transect to an existing list, follow these steps:

From the main Project Information window, click the Transect menu.
Here there are three items: Edit Transect ID, Add Transect, and Delete
Transect. Selecting any one brings up a new window where transects can
be added, deleted or renamed. Transect ID’s can be letters or numbers, up
to 15 characters.

= Add Transect(s)

% Remove Transect(s)

% Transect ID Editor Euisting Transect(s] Add New Transect D Avaible Tranzect(s) Remove Tranzect(z]

Transect 0 |
1

Trangect D [

3
| # |

[

EEEREE
00T = L R —

OO0 O e L0 RO —

Cancsl Cancel

Also there is an item here called Station Rounding to the Whole Foot. Once
this function is executed the decimal numbers can not be recovered. Also
all tables will now display the entire station number without rounding.

This is useful when detailed topographic data such as LIDAR data is used
to extract ground profiles and may have numbers out to multiple decimal
places. For long transects this may present a problem because the WHAFIS
program only allows for 6 spaces for the station number including the
decimal point. Any station number greater than 9999 does not allow the
use of any decimal places.
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The user can determine which transect is selected by viewing the Transect Status Bar
located along the top of any program window.

Transect
Status
Bar |

i) Transect General Information - Transect ID: 1

D ezcription T Parameters ]

4. Enter General Transect Information

In the Transect General Information window, information about the location, type,
and general characteristics of the selected transect is entered/edited. Click on the
button on the main Project Information window to open the Transect
General Information window:

) Tranzect General Information - Tranzect ID: 1 E

Deszcription T Parameters ]
Transect Type: ISand_l,J Beach - Small Dune j
Dezcription of Transect Location:
alang barrier izland shoreling, begin appros 280 ft zouth of monument and exstends owver dune to ;I
bay shoreline.
[ -]
Fange and Direction: Location of Station O
Range(ft] and Direction Left IEUU IEII:I #[m): ISE
rlm]: 27
Range(ft] and Direction Right IEUUEI IEII:I Bearingldd |30
Tranzect Characteristics:
IUndeveloped CBRA |area w small dunes, w/ avertopping by SWEL after dune eroded, ;I
J |

Copy | Cancel | 0k |

The Description tab is for entering general transect information as follows:

e Transect Type: Description of the shoreline type that most closely matches the
transect being modeled. Current choices are Rocky bluff, Sandy bluff-Little
beach, Sandy beach-Small dune, Sandy beach-Large dune, Open wetland,
Vertical wall, and Revetment.
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e Description of Transect Location: Description of the transect’s location relative
to local fixed landmarks. The description should be adequate for unmodified
inclusion in FIS tables.

e Range and Direction Left: Looking landward, the Range is the along-shore
distance to the left of the transect line that the transect is intended to
represent. Direction is entered as the bearing of the range away from the
transect (in degrees North).

e Range and Direction Right: Same as Range and Direction Left, but to the right
of the transect line.

e Location of Station O: Description of the location of the “zero” station to be
entered in the transect profile data. The zero station should be located at the
zero elevation or zero-foot contour line along the shoreline of the flooding
source. The unit options for these fields include decimal degrees (dd), meters
(m), and feet (ft) based on the Projection field input in the main Project
Information window. The bearing refers to the orientation of the transect
looking landward from Station 0. The unit option for this field is limited to
decimal degrees.

e Transect Characteristics: Physical and cultural description of the area the
transect is intended to represent. Include information on the presence
vegetation, structures or development, and beach material (fine sand, coarse
sand, cobble, or mud).

None of the fields described above are required to proceed to the next step;
none of the information provided in the Transect Description Information
window will be used for actual engineering computations.

If entering information for a new transect and a previous transect exists that
contains the same information as the new transect, click on the button
to fill in all the fields with information from a previously entered transect.
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5. Enter Detailed Transect Information

Click on the Parameters tab in the Transect General Information window for
entering additional details regarding the transect.

i) Transect General Information - Transect ID: 1

Dezcription T ]
Flooding 5 ounce; |.-’-'-.t|anti|: Ocean
10% chance SWEL(f) 56 Souce [FEMA Suige Model
2% chance SWELIH) 7 Source: |
1% chance SWEL[R): 10.4 Source: |FEM.¢. Surge Model
0.2% chance SWELH) 12 Source: |
bean High "/ ater Elew [ft]: lzi Source: |N|:|-'“-"-f3-

Mean Low ‘wWater Elew [ft]: -2 Tvpe of Evernt: |Hurriu:ane ﬂ

Fetch Length [mile]: 73 S W15
wave aor fetch
1% Significant ' awve Height [f]: 28 data:
0.2% Significant " ave Height [ft]; 34 SPM
1% Deepwater Wave Period [zec); 127 Method for
determing wave
0.2% Deepwater Wave Period [zec); |16 setup magnitude:

1% wWave Setup Magritude [ft): 2 axwmowe: |
02%Wave Setup Magnitude (1): 6 Q2xWwINDVH: [
1% WINDOF: | xwmorR |
0.2 % WINDOF: T ozwnor [

Other Flooding Source
Source; |Ba'3k bay 1% chance SWEL [ft); |EE 0.2% chance SWEL [R); |32

Copy ] | Cancel |

Detailed transect information regarding storm surge and wave parameters and the
source of the data are entered in the Parameters—Transect General Information
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window. Units for the majority of the data fields are established in the main Project
Information window. For Version 2.0 of CHAMP, the units in the data fields default
to English. In future versions, the units will be in English or Metric.

The following fields are required and must be completed (with the exception of Other
Flooding Source, which is optional):

Flooding Source: Name of the body of water for which flood hazards are being
analyzed (e.g., Atlantic Ocean, Gulf of Mexico, or inland bay or sound).

10% chance SWEL: 10% annual chance (10-year) SWEL without wave setup,
referenced to the stated vertical datum. Must be specified, even if value is
“zero.”

2% chance SWEL: 2% annual chance [50-year] SWEL without wave setup,
referenced to the stated vertical datum.

1% chance SWEL: 1% annual chance [100-year] SWEL without wave setup,
referenced to the stated vertical datum. Also referred to as “storm surge.”
Computed wave setup will be entered separately. It is important to use a
decimal format with one decimal digit (tenths) in this field.

0.2% chance SWEL: 0.2% annual chance [500-year] SWEL without wave
setup, referenced to the stated vertical datum. Also referred to as “storm
surge.” Computed wave setup will be entered separately. It is important to use
a decimal format with one decimal digit (tenths) in this field.

Mean High Water Elevation and Mean Low Water Elevation: Referenced to the
stated vertical datum. Must be specified, even if value is “zero.”

Fetch Length: Measured in miles, the maximum open water reach over which
storm-induced winds are expected to occur. Maximum effective value is 24
miles. A “zero” can be entered if deepwater wave conditions are specified.

1% Significant Wave Height: Wave height associated with the 1% annual
chance storm event, given in feet. Must be specified for WHAFIS and RUNUP
analyses. A “zero” can be entered if the subject area has a restricted fetch and
the Fetch Length will be used to calculate a wave height or if only analyses for
the 0.2% annual chance event are being run.

0.2% Significant Wave Height: Wave height associated with the 0.2% annual
chance storm event, given in feet. Must be specified for WHAFIS and RUNUP
analyses. A “zero” can be entered if the subject area has a restricted fetch and
the Fetch Length will be used to calculate a wave height or if only analyses for
the 1% annual chance event are being run.

1% Deepwater Wave Period: Wave period associated with the 1% annual
chance deepwater wave height. Required for WHAFIS and RUNUP analyses. A
“zero” can be entered if the subject area has a restricted fetch and the Fetch
Length will be used to calculate a wave period or if only analyses for the 0.2%
annual chance event are being run.

0.2% Deepwater Wave Period: Wave period associated with the 0.2% annual
chance deepwater wave height. Required for WHAFIS 4.0 and RUNUP 2.0
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analyses. A “zero” can be entered if the subject area has a restricted fetch and
the Fetch Length will be used to calculate a wave period or if only analyses for
the 1% annual chance event are being run.

e 1% Wave Setup Magnitude: Value, in feet, of apparent wave setup effect to be
added to 1% annual chance SWEL. Must be specified, even if value is “zero.”

e 0.2% Wave Setup Magnitude: Value, in feet, of apparent wave setup effect to
be added to 0.2% annual chance SWEL. Must be specified, even if value is
“zero.”

o 1% & 0.2% WINDOF: Wind speed associated with the 1% & 0.2% annual
chance storm events for the OF card in WHAFIS. If left blank the default will
be used by the WHAFIS program.

e 1% & 0.2% WINDVH: Wind speed associated with the 1% & 0.2% annual
chance storm events for the VH card in WHAFIS. If left blank the default will
be used by the WHAFIS program.

e 1% & 0.2% WINDIF: Wind speed associated with the 1% & 0.2% annual
chance storm events for the IF card in WHAFIS. If left blank the default will be
used by the WHAFIS program.

e Source of Annual Chance Stillwater Elevations: Description of methods or
references used to determine the SWEL.

e Source of Mean High and Low Water Elevations: Description of the methods or
references used for determining specified mean high water (MHW) and mean
low water (MLW) elevations.

o Type of Event: Description of the type of flooding event being analyzed. Drop-
down list includes such options as Northeaster and Hurricane.

e Source of Wave or Fetch Data: Description of methods or references for
determining wave or fetch conditions.

e Method for Determining Wave Setup Magnitude: Description of methods or
references used for determining wave setup magnitude.

The Other Flooding Source data fields at the bottom of window are optional. They can
be used to enter information about a flooding source not related to the main flooding
source as a transect traverses landward. An example of this is when there is a barrier
island with a body of water between the island and the mainland.

Click @ to return to the main Project Information window, or click the close button

(x).
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4.2 Program 2: Transect Data Entry and Editing

The Transect Edit Program window can be opened by clicking the button
on the Main Menu Button Bar. Transect ground profile station and elevation data are
entered here. The data can be the unadjusted, non-eroded profile information or
eroded profile information and will be used in all analyses and modeling programs.

For this version of CHAMP, all station and elevation data for the transect must be in
feet.

B, Transect Edit - Tranzect ID = 2 M= E3
Filz  Edit
[ | =
Tranzect Adusted| Graph Refresh
STATION ELEVATION SOURCE
2670 -34 B athprnetric Map
1500 22 B athpretric Map
-6 -4 B athpretric Map
] I} Surveyed
7h A Surveyed
100 10 Surveyed
200 15 Surveyed
275 10 Surveyed
400 3 Surveyed
3500 104 Topo Map
*
o

Transect station and elevation data can also be imported by selecting the Import menu
item under the File menu. CHAMP only allows importing comma-delimited text files
(.csv) for importing station and elevation data for a transect. This works much the
same as importing project data described above.

The Station and Elevation column data must extend seaward to at least the zero
shoreline. However, it is often necessary for the data to extend much further offshore
if dune-retreat-eroded-profile transects or wave runup are to be modeled. Profile data
should extend onshore (inland) to a point where coastal stillwater flooding likely ceases
or to the limit of maximum runup elevation.

The Source column lists the source of the transect profile data. Options for this
column include Surveyed, Topographic Map, Bathymetric Map, Global Positioning
System (GPS), Digital Terrain Metadata (DTM), and Light Detection and Ranging
(LIDAR) data.

To enter additional station/elevation data points, enter data at the row indicated by

the located at the bottom left corner of the input data fields.
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Command buttons at the top of the Transect Edit Program window include:

. : Displays Transect Edit window

o : Displays Adjusted Transect Edit window. Using this button
creates the adjusted station-elevation table in the database, which will be used
by the other programs. If this table is not created, the other programs cannot
be run. If a (0,0) point is not available, this button adjusts the profile
accordingly by interpolating or adding a zero elevation (NGVD 29 or NAVD 88)
and corresponding station, which is required by WHAFIS. Notice that this
dialog box is similar to the Transect Edit window, except for the addition of
the Adjusted Station column. This column displays the interpolated (0,0)

shoreline point, if such a point was not a part of the original transect data.
The Source column contains the text “interpolated” for the interpolated (0,0)

B, Tranzect Edit - Transect ID = 2 [_ O] x|
File  Edit
]
Transect| Adjusted  Graph Refresh
STATION ADJSTATION ELEVATION SOURCE
267 2670 -34 Bathymetric Map
1500 1600 -2e B athymetric Map
&0 -Gl -4 B athymetric Map
0 i) 1] Surveyed
7a ki 3 Surveyed
100 100 10 Surveyed
200 200 15 Surveyed
270 275 10 Surveyed
400 400 g Surveyed
3500 3500 10.4 Topo Map

point.

. : Displays either the transect or adjusted transect data in graphical

format depending on which table is displayed at the time this button is clicked.
The [nserf and

insert and remove data
the changes made, the

buttons are visible only in graph mode and are used to
points in the graphical view of the transect. To view
button must be clicked. The database table will

not get updated until the Update table menu item is selected from the Graph
menu. To undo the changes made to the graphical display of the transect,
click on the button or exit the Transect Edit program without
updating the table. A point identifying the Primary Frontal Dune (PFD) can be
added when viewing the adjusted transect graph. Under the Graph menu,
select Landward Toe (PFD), then select the point along the transect where the

landward limit of the primary frontal dune is located. To learn about the
function of the graphical displays, see section 4.7 below titled Graphic

Controls.

CHAMP Version 2.0 August 2007

21



Coastal Hazard Analysis Modeling Program—User’s Manual

NOTE: The Adjusted Transect graphic must be displayed in order to open up
the Erosion Assessment Program Window.

. : Reformats Field Station and Elevation columns in numerical order of
station value if new data are entered. New station and elevation data can be
entered at the bottom of the data entry fields.

After inputting the transect information as summarized in the Project & Transect Data
Entry Procedures flowchart (on the following page), CHAMP allows the user to analyze

and model data. The remaining sections of Chapter 4 offer a detailed description of
Programs 3 through 6.
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Project & Transect Data Entry Procedures

Click Start Main Project Window—No Open Project

Splash Screen I Click

Import Data

Eio Diansect Brogiam  Help

| e |
Federal Emergency Management Agency ':n IE:- GEI“ '?‘:ﬂ Eﬁ. aq ﬁf u.!;- r;{n Im Ort Pt [ ekdtem =
5 v | oo WHAFIS Furp 2 ——3
<~ CHAMP »

[— |
e o 5
i [ttt E

@-ﬂm-ﬂmwﬁw
Click

1 New Project Click Open

S [ e ol New a
== I
. . o .
Z Main Project Window—Open Project
g F— o -
L - (=] )} Coastal Hazard Analysis Modeling Program e | %
File Transect Program Help
Click o 2| @ B @ | B Y ] Click
Mew  Open | Gemeral Tramsect | Erosion WHAFTS Runup | Graphics Tables | TransectiD >| € 100w & 500y
Save Open
Frojest Database™ | i Viettical Datur: NGVDZ3 -
Project Title: ‘Eamp\e Data Prajection: Lat/Long -
> Madsler Name ‘Juhn Doe Transect Urit System*  [English -
Community Mame: ‘Enasla\ Town USA Estimated FIRM Gcale:  [17=500 -

Clent Name. [FEMA Wumberof Transeats*  [& Updste

Select a transect ID

Click General
3 Transect Description 3 Transect Parameters
4D Tramsect Gamesal Informatien - Tramseet 10: 1 [

Dascipton Pasameteas

D= 1 Parameters 1

Transeet Type:  [Sandy Beach - Small Dune = |

Description of Transect Losation

[&lerg bartier island shorelin, begin appros 250 ft south of monument and estends over dune fo <]
bay shoreline.

0% chance SWILP

M High Wiates e I} 2 Souce ey

J |

i Lo Wates Elee (4]

FehLongth
Range and Direction: Location of Station 0 Ll

™
1% Sigrifcant W Haght i) i
Range(ft) and Direction Left 500 90 Alm 85 e Somotwenttesiot [T
] 27 s s - i :
Range{t] and Direction Right ~[5000 30 Bewingidel [0 Cth m T

Transect Characteristics:

Undevelaped CERA [area w7 small dunes, wi avertopping by SWEL after dune eroded

|

Click Transect

O%had Flocling Soucs
Copy Cancel oK Sousce [Dack bay 1% chance SWELME (B 0.2% chance SWEL Iy [13
Coxy o Carvcel

Yes for permanent
Transect Data Table OVERWRITE

Click
5, Transect Edit - Transect ID = 2 [_ O] =] Comprehensive Coast Study
Fie Edt Im[gort Yoo ey beve dota o this wensect

= = ' Doy winl 15 G wikes hageri?
Trarsect Adusted| Graph Refresh —

Yew Ho I

[

STATION IEEVATIUN SOURCE
[ |-2570 EN) athymetic Map
500 2 sthymetic Map
&0 4 athymetic Map
1] 0 urveyed
75 5 Surveyed
100 10 Surveyed
200 i Suveyed Import Text file
27 10 Surveyed . "
[ 8 Surveped Click O (import .csv file from excel)
3500 104 Topo Map
_ ick Open

4 s [& EEE]

Click Adjust S e—
(mandatory)

5 Adjusted Transect Data

=, Transect Edit - Transect ID = 2 [_O[=]
File Edit
[o. &
Transectf 4djusted Graph Refiesh
| |STATION ADJSTATION ELEWVATION EEIUF(EE
b ]-2e7d 2670 34 Eathymetiic Map
. 1500 500 2 athymetic Map
6 Close Window, select o 0 E] shymsiic Hap
[1 [1 [ urveped
75 75 5 urveyed
another transect 0 10 g e .
7 75 i urveyed Cth
L 00 urveyed
=T 50 ] opoep Transect
- Aransect
| Z View graph of transect

OR Close Click w0 (B[

Tusnsect] Adumied)| Gish | Hohesh| leaet | Bemove

Window Graph

7 Go to:

Erosion Assessment
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Before proceeding on to the remaining programs for performing the analysis
the user can choose whether to work with the 1% annual chance wave
modeling mode or the 0.2% annual chance wave modeling mode by selecting
the appropriate button on the Main Menu window. This will allow for
working with the data separately for each mode. The data for each mode is
stored separately. Each window under the analysis Programs will identify
which mode is being worked on in the title bar at the top of each window.

/

1o: 1 bl 100y (s GOOyr

e Mode selection

Graphics  Tables

Wertical D aturn WNEYD 29 -

Projection Lat/Long -

Trameank | Lk Coskana® Frnlich -

4.3 Program 3: Erosion Treatment
1. Introduction

Wave analysis transects normally undergo FEMA’s standard erosion treatment before
being used as input to the WHAFIS 4.0 or RUNUP 2.0 models. The G&S should be
referenced for more detailed descriptions of the terms and procedures used for
performing the erosion treatment. For cases where the existing transect data already
represent the eroded profile, or erosion will not be applicable (i.e., hardened shoreline
or rocky coast), the user can bypass this program. It is particularly important that the
1% or 0.2% annual chance SWEL and profile data be firmly established before
performing the erosion treatment.

CHAMP assists the user in performing the erosion treatment and adjustment through
the Erosion Assessment Program window, which is accessed by choosing the
button on the Main Menu Button Bar.

The Erosion Assessment Program will display the adjusted transect data on a graph
of Elevation versus Distance (station), with increasing stations being landward.
Horizontal lines representing the 1% and 10% annual chance SWELs (without wave
setup) are also shown. The interactive user controls are accessed through the tool bar
at the top of the editor window. These controls include the following functions (left to
right):

e Set Peak
e Set Toe

e Set Face Slope
e Set Approach Slope
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e Set Seaward Slope

e Set Remove Slope

e Computed Reservoir Area

e Deposit Area

e Erosion Profile Status

e Total Eroded Area

e Eroded area above SWEL
In addition, the user must enter or confirm default values for one or more of the
following parameters, as applicable: Seaward Slope (1/12), Face Slope (1/1), and

Approach Slope (1/40) for “Retreat” profiles; or Removal Slope (1/50) for “Removal”
profiles. Note: default values are in parentheses; slopes are vertical/horizontal.

To get a closer look at the transect profile segments, use the View item under the
Graph menu or right-click on the graphic screen to activate a prompt to the following
functions: Zoom Window, Zoom In, Zoom Out, Full Extent, and Pan. See section 4.7;
Graphic Controls for a description of the View commands as well as all graphic
commands.

Setup under the Graph menu is used to adjust axes scales and intervals. See section
4.7 for a description of the Setup options.

1 Erosion Assessment Program: Transect ID: 1 Model: 100yr
File Edit Graph

(" Peak: |348.53|24853 (" Face: |1 " Seaward |12 Reservain Total Eroded Area: 537 Stat RETREAT
atuis:
e 20466 |E5129  Approach: |40 f_“ 50 Deposit: 530 Eroded above SWEL:

- - — - - - - - - - - -

£ >
-380.218,1447.118 SMAP OFF GRID OFF  |CRTHO OFF  |OSNAP OFF

= -3802 Y= 2849
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The erosion assessment analysis is performed graphically by selecting points along the
profile. The program requires the user to select these points. The following step-by-
step instructions outline the procedures for performing a frontal dune erosion
treatment within CHAMP. Instructions consider frontal dune erosion treatment for
ground profiles where the dune crest is: A) above; and B) below the 1% or 0.2%
annual chance SWEL.

2. Dune Crest Above 1% or 0.2% Annual Chance Stillwater Elevation
a. Establishing Dune Reservoir
Selecting the peak of the dune:

Click on the Peak field on the top of the window. Click on the profile where the
appropriate peak of the dune is located. The coordinates of the point selected will be
shown in the data fields next to the Peak field. The program will draw in the dune
reservoir and calculate the area of the reservoir and show this value in the Reservoir
field. If the peak needs to be moved or reselected, this can be done by clicking on the
Peak field again and selecting the new dune peak location on the transect.

NOTE: The minimum value of the dune reservoir before the dune is considered
removed is the FEMA standard value of 540 sq. ft. for the 1% annual chance flood and
1,030 sq. ft. for the 0.2% annual chance flood for the or the Atlantic Ocean, Caribbean
Sea, and Gulf of Mexico. The program will also show whether the dune is removed or
retreated in the Status field.

The reservoir is calculated as the cross sectional area between the SWEL (without
wave setup), a vertical line drawn through the dune peak, and the transect ground
profile for the foreshore dune area (seaward of the dune crest). If this area is less than
the critical area of 540 sq. ft. for the 1% annual chance flood or 1,030 sq. ft. for the
0.2% annual chance flood, the profile adjustment will be for dune removal, and noted
as “Remove” in the Status field. If the computed area is greater than or equal to the
critical area, the Status field will be adjusted to reflect dune retreat, and noted as
“Retreat” in the Status field.

b. Method for Dune Removal
If the dune is eroded, follow the steps below:

Click the Toe field and select the appropriate place along the profile that best
represents the location of the dune toe. The toe of the dune can also be approximated
by the intersection of the 10% SWEL with the seaward side of the ground profile. The
dune toe can be changed by clicking on the Toe field again and reselecting the point on
the profile.

The program defaults to using the standard slope for an eroded profile as 1 on 50. If
an alternate slope is desired, the value can be changed in the Remove field. Click on
the Remove field button. The program will draw the eroded profile and calculate the
eroded area as shown in the Total Eroded Area field.
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{(* Erosion Assessment Program: Transect ID: 2
Fil= Edit Graph

" Toe: |81.?53|E.3505 Approach: |4D € Rlemove: IED Deposit: I-SSSS Eroded: ISSSS

A § ’ Adjusted Tranzect
Dune Toe

c. Method for Dune Retreat

" Peak: |2|:|2.19|14.853 ) Face; |1 £ Seaward: |12 Reservair  |222 Status: IHEMDVE
»
A

H= 6635 Y= 9.0

If the dune is retreating, follow the steps below:

Define the eroded area of the dune. First click the Face field and select the position for
the 1-on-1 eroded dune face that is a best initial guess where the eroded area may be
equal to 540 sq. ft. for the 1% annual chance flood and 1,030 sq. ft. for the 0.2%
annual chance flood. Check the Eroded above SWEL field to see what the eroded area
is. If the eroded area is not equal to or close to 540 sq. ft. for the 1% annual chance
flood and 1,030 sq. ft. for the 0.2% annual chance flood, then re-select the position of
the eroded dune face and check the Eroded above SWEL field again. Repeat this until
the eroded area is equal to or close to the 540 sq. ft. for the 1% annual chance flood
and 1,030 sq. ft. for the 0.2% annual chance flood.
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Determine the seaward slope and position that best gives a deposition area that closely
matches the eroded area (check the Deposit field). Select the Seaward field and then
select the position for the 1-on-12 slope by clicking on the graph. This will place a 1-
on-12 slope line on the screen. The seaward slope will be placed at the position of the
mouse cursor, and the program will calculate the deposition area as shown in the
figure below.

{iz* Erosion Assessment Program: Tranzect ID: 4
FEile Edit Graph

" Peak: |251.?5 J44E5 7 Face: l'l_ " Seaward: IF Reszervair: Status:
c [9399 [-9399 = Appoack: [40 € 50  Depositt  [513 Eroded: [525

Check the Deposit field to see if it matches the Total Eroded Area field. If they match
or are close, the erosion treatment is complete. If they are not close, the selection of
the seaward slope can be repeated until the deposition area matches the eroded area.

3. Dune Crest Below 1% or 0.2% Annual Chance Stillwater Elevation

For profiles where only the dune crest is below the 1% or 0.2% annual chance SWEL,
follow these instructions:
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Click on the Peak field on the top of the window. Click on the profile where the
appropriate peak of the dune is located. The following window will appear. Click
to proceed with removing the dune.

x

_an not find intersection between the 100-vear SWEL and the profile.
Do you want ka kreat this as a dune removal case?

Click the Toe field and select the appropriate place along the profile that best
represents the location of the dune toe. The toe of the dune can also be approximated
by the intersection of the 10% SWEL with the seaward side of the ground profile. The
dune toe can be changed by clicking on the Toe field again and reselecting the point on
the profile.

The program defaults to using the standard slope for an eroded profile as 1 on 50. If
an alternate slope is desired, the value can be changed in the Remove field. Click on
the Remove field button. The program will draw the eroded profile.

For profiles where the entire ground profile is below the 1% or 0.2% annual chance
SWEL, the following window will automatically display when initially entering the
Erosion Assessment Program:

x

The 100-year SWEL is above the highest elevation Far the entire prafile,
Therefore, it is kreated as a dune remowval case.

Click on to remove the dune and follow the instructions above for selecting the toe
and drawing the eroded profile.

4. Saving and Exiting the Erosion Treatment Model

To clear out the erosion profile in the database, click the Clear Model menu item under
the File menu. This can be used when an erosion analysis was performed previously
and the user wants to re-do the erosion analysis or if the user wants to run WHAFIS
or RUNUP with the non-eroded adjusted transect data.

WARNING: Once the clear model command is selected the erosion table in the
database is cleared and can not be undone or brought back. The user needs to
perform the erosion analysis again.
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When the user is satisfied with the eroded profile slopes and the eroded and deposited
areas, the erosion profile needs to be saved in the database by selecting the Save
Model menu item under the File menu. CHAMP will then create a data table for the
eroded profile, which will be used as the WHAFIS 4.0 and RUNUP 2.0 input files in
Programs 3 and 4.

Exit from the Erosion Graphic Editor window by clicking on the window closure BI

in the upper right corner. As a precaution, the program will ask if the user wishes to
save any changes made to the erosion profile. Click if you wish to save changes or
if you wish to disregard any changes made.
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4.4 Program 4: Wave Height Analysis

This program is used to specify the input parameters for and run the Wave Height
Analysis for Flood Insurance Studies (WHAFIS 4.0) program on the selected transect.
Consult the G&S for more detailed information on the WHAFIS program. To begin the
wave height analysis, click on the button on the Main Menu Button Bar.
The WHAFIS Program window shown below will open.

QI WHAFIS - Transect ID: 1 Model: 100yr

File Program Resulks
)
Data Graph | Refresh
Station | Elevation | WHAFIS Card | Total 1% SwEL | | oadl® M PS
AT 0,00/ IE 2.4 EE
0 5 47|IF 0 0
5764119 811|IF 0 0
H7.0674 10.40(1F i n
Hooama 12.40(F i n
EOO.05 12.40/AG 12.4 n
E50| 10.00(1F i n
700 2.00|IF 0 0
500) 10,40 1F 10.4 0
*

1. Transferring adjusted data to WHAFIS Program

Click the Populate Data item under the File menu to extract data from either the
eroded transect or the non-eroded transect data entered in the Transect Data Entry
and Editing Program. The station and elevation columns in this window will be filled
in with the transect data. WHAFIS uses points only from the zero elevation
shoreward. These will be the only stations used for WHAFIS input cards. WHAFIS will
populate only with data points that are equal to or below the total stillwater level (1%
or 0.2% annual chance SWEL plus wave setup). If there are no data points where the
total SWEL intersects the ground the program will automatically insect data points at
every occurrence where the profile crosses the total SWEL. Segments above the total
stillwater level are automatically considered X zones and are not needed for the
WHAFIS program. The WHAFIS 4.0 Program is limited to 1,000 data points per
transect. Therefore, some data points may need to be removed before running the
program.

2. WHAFIS card selection

The WHAFIS Card column will be defaulted to the IF card except for the first card.
The first input card to WHAFIS must always be an IE card. By clicking on a field for
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each station, a drop-down menu will appear with all the card options for WHAFIS.
Click on the appropriate card for each station. By selecting or double-clicking on a
card field that requires additional input (e.g., VE, VH cards), an input window will pop
up for that card. Fill in all the fields with station-specific information.

IMPORTANT: When editing the VH card, click on the button to enter
additional data. When a plant type is selected from the drop-down menu in the
MG card window, plant parameters will default to zero which implies WHAFIS
program-provided default values. The user can also manually enter plant
parameters in order to override WHAFIS default values. If entered manually,
Unflexed Stem Height and Frontal Area Ratio parameters should be entered in
feet; the Number Density parameter should be entered in inverse square feet;
and; Base Stem Diameter, Mid Stem Diameter, and Top Stem Diameter
parameters should be entered in inches. These units are used in WHAFIS, and
therefore do not have to be converted.

Values should not be taken directly from the G&S ‘Table D-12: Significant
Marsh Plant Types in Each Seacoast Region and WHAFIS Default Regional
Plant Parameter Data.

3. Annual chance stillwater elevation discussion

The Total SWEL field for the first station will be filled in with the annual chance SWEL
plus the setup entered in the Transect Description/Parameter Entry Program. If
there is a change in the annual chance SWEL as the transect proceeds inland, enter
the new annual chance SWEL in this column at the appropriate station. The SWEL
change is possible where the transect crosses over a barrier island and extends across
an inland bay or other secondary flood source. If the open coast barrier island or
mainland ground elevations rise above the annual chance SWEL plus setup, the
transect will terminate. If the transect extends into a secondary flood source or
further inland flood areas, then the setup should be taken out of the total SWEL value.

A function exists in CHAMP where station-elevation pairs are automatically inserted at
all locations where the ground elevation profile crosses the 1% (or 0.2%) annual
chance SWEL. Thus, this function will add two points for a profile that rises above
and then falls below the 1% (or 0.2%) annual chance SWEL. A station will need to be
inserted manually where the ground elevation crosses the 1% (or 0.2%) annual chance
SWEL plus setup. Further refinements of the SWEL changes and new station
locations can be made via the graphical display (See Step No. 4). Refer to the G&S for
further guidance on WHAFIS modeling for SWEL changes. See below on how to insert
a transect point.
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4.  Graph display of WHAFIS input and eroded or adjusted transect data

Click on the button of the WHAFIS Program window to plot the transect as
shown in the window below. Additional data points can be inserted from this window.

LI WHAFIS - Transect ID: 1

File Program  Graph Besulks

E | W B[S

Data | Graph  FAefresh| Insert

[Z]

Femo...

== 10308 = 246

The plot will show all of the original adjusted (blue) or eroded (yellow) profile ground
elevation transect points and line. The transect points and line being used for the
WHAFIS input will be represented in magenta. The total 1% (or 0.2%) annual chance
SWEL (with wave setup if applicable) will also be plotted as a yellow dashed straight
line across the graph. To get a closer look at the profile, as described previously, click
on View or right-click the mouse on the graphic screen (see section 4.7).

To add a transect point, click on the button and then click on the point along
the profile where the additional points are needed. Click on the button to
update the graphic view to see the results of the inserted points. The station and
elevation of the new points will not be inserted into the WHAFIS data input table
until the table is updated by clicking on the Update table menu item under the
Graph menu. Click on the button or return to the WHAFIS data input table to
complete the fetch and WHAFIS card fields for the inserted point. If the inserted
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points are not wanted the results can be undone before the table is updated by
switching to the table view and then back to the graph; the inserted points will be
removed. If a data point needs to be removed from the WHAFIS input, select the
points to be removed by clicking on them and then clicking the button.
Again, the button needs to be clicked to see the results of the removed points,
and the table will not be updated until the Update table menu item under the Graph
menu is selected.

Warning: If the button is clicked to return to the table view without
first updating the table with the inserted or removed data points, the
changed results of the inserted or removed points will be lost.

5.  WHAFIS computational application

Click on the Run WHAFIS item under the Program menu WHAFIS Program window to
execute the WHAFIS program. A DOS-run window will open; it will appear either
minimized or opened on screen. When “Stop — Program terminated” appears in the
DOS window, the WHAFIS program is complete and the DOS window can be closed. If
the WHAFIS program ran successfully, a “WHAFIS RUN finished” box will appear; click
on the OK button. If WHAFIS did not run correctly, an error message will appear and
the input file should be checked for errors.

6. Graphical display of WHAFIS output data

Click on the Graph Results item under the Graph menu while in the graphic view of
the WHAFIS Program window to see a graphical plot of the WHAFIS results. This will
bring up a plot of the profile showing input profile, SWELSs, and the wave envelope.
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L WHAFIS - Transect ID: 1

File Program Graph Besultz

W B S

Data § Graph  Refresh| Insert

Z]

Remo...

il

®= 152258 %= -21.1

A hatched color-coded bar at the bottom of the plot represents the different zones:

e VE Zone—Red
e AE Zone—Green

o X Zone—Yellow
Other lines within the graphical display correspond to the following elevations:

e Total 1% or 0.2% annual chance SWEL (1% or 0.2% annual chance SWEL plus
wave setup)—Dark blue line
e Wave Crest Elevation—Purple line
e Zone Elevation Designations—Stair-stepped line, the color of which
corresponds to the zone bar colors at the bottom of the plot.
7. Return to main data display

Click on the Data button to return to the WHAFIS input table.

If the WHAFIS graphic is viewed again the graph will go back to showing the WHAFIS
input profile. The Graph Results menu item needs to be selected again to view the
results to the WHAFIS model.
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8.

WHAFIS data viewing

The Results menu of the WHAFIS Program window includes the WHAFIS input and

output results. The input and output text files, and WHAFIS output files (in six parts)
can be viewed and printed in table format. The different output parts are shown
below.

Part 1 is the input information.

File

\Eﬁfbﬂs FIELD1 |FELD 2 |FELD2 |FEWD 4 |FELDS |FELDE |FIELD7 |FELD® |FELD 9 |FIELD 10 |FIELD 11

IE 000 | 000 | 24000, G600| 12400 44800 12700/ 000 | 067 | OGO

IF 75000] 5000 000 | 12400] 000 | 000 | 000 | 000 | 032 | 000

IF 302000 9560 GEOD| 12400| 000 | 000 | 000 | 000 | 009 | 000

WH 400000 8000 2000 1000|000 | 1.000| 000 | 12303 000 | 000

MG SP&T| 100 | 000 | 850 | a27OnC 000 | 000 | 000 | .ooo | .ooo

WH 730300 9500| 2000 000 000 | 1000|  GE00| 10400 oo Fi

MG SPAT| 100 | 000 | 850 | 327000 000 | 000 | 000 | 000 | 000 —
WH /0000 10400 2000 1000 000 | 1000|000 | 10.400] 001 000

MG SP&TI 100 | 000 | 850 | ae7oo0 000 | 000 | 000 | 000 | 000 hd

Part 2 shows the controlling wave heights, spectral peak wave period, and wave crest
elevations for the data entry points and all WHAFIS interpolated values.

M=
File
WHAFIS |orarigul  weve|  weve e
CARD HEIGHT| PERIOD| £\ g
IE 0 948 127 9.0
IF 7 EE3 127 16,38
T77E 413 127 15.29
a2 2G| 127 1413
IF 03 22 127 13.04
VA a0 229 127 1291
] 220 127 13.69
710 21| 127 13.45
1030 18 127 13.01
10 1A 127 12.55
670 143 127 12.08
1990 114|127 1151
SE0[ 04| 127 1119
VH 5303 07 127 10,89
2453 061 127 10,83
13 052 127 10.76
o333 033 127 10,63
53 014 127 105
WH w00 om| 127 10.41
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Part 3 shows the location of areas above the 1% (or 0.2%) annual chance Total SWEL.
If no areas are above the 1% (or 0.2%) annual chance surge, no table will be displayed.

Eil=
STATIOW]|STATION
EEGIM EMD
140 30
9ER 1182

Part 4 shows the location (if any) of Total SWEL changes.

File

STATION 10 ear| 100-Year
Surge Surge

400 .5 123
2303 E.5 10.4

Part 5 shows the locations (if any) of the V Zone to A Zone boundary (windward) and
the A Zone to V Zone boundary (leeward).

Eil=

STATIOMN| Lacation

251.18)  wiND
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Part 6 shows the station and location of the 1% annual chance (or 0.2% annual
chance) flood elevation and respective A Zone and V Zone designation. Refer to the
G&S for additional details on output interpretation and mapping of coastal areas.

i
ELEVATI ZOME
ST’;EEH oM ST’”E'ﬂE EDLrEEﬁT[:! ZOME | ELEVATI FHF
BEGIM oM
ol 1901 46| 165/viG 15 30
146 185 431 17618 18 30
431 176 716 165vIg 17 50
716 165 1579  155/vig 16 50
157.9] 155 2511 14518 15 30
2511 145 2511 FEGE 15 30
o511 145 03 13.94]A17 14 E5
03 1394 400 13.91(A1T 14 E5
400 1391 6823 135/A1T 14 E5
623 135 13825 125|411 13 E5
13625 125 19939  115/A11 1z E5
1993.9) 115 z303]  10.89A17 11 E5
2303 1089 32565 105|ATT 1 E5
IEEE| 105 3500[  10.41|ATT 10 E5

9. Exiting WHAFIS Program

When finished with the Wave Height Analysis Program, close the WHAFIS windows
by clicking on the in the upper right corners on each window. Then, continue with
Program 5, or proceed to Program 6.
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4.5 Program 5: Wave Runup Analysis

This program is used to run the FEMA RUNUP (Version 2.0) model on the selected
transect. The FEMA RUNUP model applies only to runup on sloped beaches. The U.S.
Army Corps of Engineers Shore Protection Manual (1984) should be consulted for
runup on vertical walls and armored rocky revetments. The G&S should be consulted
for a detailed description on applying runup and running the FEMA RUNUP model.

To begin the RUNUP program, click on the RUNUP| button on the Main Menu Button
Bar. The window shown below will open:

4 RUNUP - Transect ID: 1 Model: 500yr EI[E|E|

File Program Results
e B Avg. Runup: 2% Runup:
Station | Elewation DEET::F;::: of Hﬂigﬁ?c?:rﬁf Station Status Mote

3 -34[5MO00TH 1| Evclude @ Include

-22|5M00TH 1| Evclude @ Include

-10{5M00TH 1| Evclude @ Include

-4/ SMO0TH 1@ Exclude Cnclude

0|5MO00TH 1| Evclude @ Include

5/5M00TH 1| Evclude @ Include

10/SMO0TH 1| Exclude  iinclude

20{5M00TH 1@ Exclude Cnclude

25/5M00TH 1| Evclude @ Include

20{5M00TH 1@ Exclude Cnclude

10{5M00TH 1@ Exclude Cnclude

8/5M00TH 1@ Exclude Cnclude

10.4|5M00TH 1@ Exclude Cnclude

* {iErclude Crinclude

1. Transferring adjusted data to RUNUP program

Click on the Populate item under the File menu to fill in the Runup Program window
with data from the transect. The Station and Elevation columns will be filled in with
all of the transect eroded profile data points (both offshore and onshore).

2. Selecting roughness coefficients

The Description of Surface column will be defaulted to smooth. By clicking on each
field for each station, a drop-down menu appears where a selection of the type of
runup surface can be made. The Roughness Coefficient column will be defaulted to 1
for smooth runup surfaces and will adjust automatically based on the Description of
Surface column input. Click in the field of each station to change the coefficient.

3. Transect data point selection for wave runup analysis
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The Station Status column is for indicating which stations will be used for input into
the RUNUP model. The RUNUP Program is limited to 20 data points per transect. The
selected button indicates that either the station is excluded and will not be used as
input, or the station will be included for input. The default is to exclude the stations.
Stations or data points can be included or excluded by clicking on the appropriate
button under Station Status. All data points landward of the highest point on the
runup slope should be excluded.

4. Annotations for selected data points

The Note column is for entering any comment necessary to describe the runup at a
particular station. Just click on the appropriate row and enter the comment.

S.  Setup for RUNUP program

Selecting the Setup for RUNUP program item under the Program menu opens the table
shown below.

. Setup for RUNUP Program |

Type of Event: I!-’-‘-.tlantin: Ocean

Mean ‘W ave Height [ft): |'| 7.528 Spread [%): |5
Mean ‘W ave Period [=]: |'| 0.735 Last Slope: I?
Stillveater Elewation [f): |'| 0.4 Job Mumber: |'|

ok | Hep |

a. Wave Information

The Type of Event, Mean Wave Height, Mean Wave Period, and Stillwater
Elevation data fields will be filled in automatically according to the data
entered in the Detailed Transect Information window on the Parameter
tab in the Transect Data Entry and Editing Program. Adjustments from
“Significant” to “Mean” wave height and wave period conditions are made
automatically. These data can be changed here if necessary.

b. Defining range for wave height and wave period characteristics

The Spread data field will be defaulted to 5%. This field is for specifying
the range of wave heights and periods for RUNUP to use. RUNUP will use
the 5% higher input wave height, the unchanged wave height, and the 5%
lower wave height, in combination with the 5% higher and lower wave
period. An additional spread value of 10% can be specified if the 5% range
is not deemed significant.

c. Last slope for extended hypothetical profile

The Last Slope field is for entering the slope immediately landward of the
last profile point. This field defaults to 50 and should be changed to
represent the current profile.
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d. Tracking wave runup projects
The Job Number field is for identifying the RUNUP run and will be used in
the titles of the RUNUP input and output. It can be numeric or alphabetic,
and its default is 1.

Click on the OK button to continue with the RUNUP analysis.
6. Graph display of RUNUP input transect data

Click on the button of the RUNUP Program window to plot the transect. The
runup profile and results will be plotted in red. Additional data points can be inserted
or removed from the graph window in the same way as described previously in section
4.4 Wave Height Analysis. The button needs to be clicked to see the results of
the inserted or removed points, and the table will not be updated until the Update
table menu item under the Graph menu is selected.

Warning: If the button is clicked to return to the table view without
first updating the table with the inserted or removed data points, the
changed results of the inserted or removed points will be lost.

7. RUNUP computational application

Once all input for the RUNUP model is complete, click on the Run RUNUP item on the
Program menu to run the model. A DOS-run window will open. When “Stop —
Program terminated” appears in the DOS window, the RUNUP program is complete
and the DOS window can be closed. If the RUNUP program ran successfully, a
“RUNUP RUN finished” box will appear; click on the OK button. If RUNUP did not run
correctly, an error message will appear.

8. Display of RUNUP results

The average runup depth computed from the model results and the 2% runup value
(Avg. Runup * 2.23) will be displayed in the Avg. Runup and 2% Runup fields in the
upper right corner of the Runup Program window. To view the input or output text
files, click on the Results drop-down menu and select the appropriate choice. A table
of the RUNUP results of all wave heights and periods run can be seen by clicking on
the Results menu and selecting OQutput Data Table. A table similar to the one shown
below will be displayed.
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File

WATER DEEF BREARINI o)y p| RUMUR
LEVEL) WATER| ‘wAVE| G SLOPE| "o qpp| ABOVE| BREAKE
ABOVE|  wWAVE[ PERIOD WUMBER| W&TER|R DERTH

DATUM] HEIGHT MUMBER LEVEL
10.4 16.7 10.3 2 3 1.67 266
10.4 167 10.8 2 3 1.84 26.97
10.4 16.7 1.3 2 3 1.84 27.34
10.4 17.5 10.3 2 9 1.75 2769
10.4 17.5 10.8 2 9 1.92 28.07
10.4 17.5 11.3 2 3 1.92 28.45
10.4 18.4 10.3 2 3 1.84 289
10.4 18.4 10.8 2 3 1.84 29.3
10.4 18.4 11.3 2 9 202 29.69

9. Graphical display of RUNUP results
To view a graph of the RUNUP profile and results, click on the Graph Results item

under the Graph menu while in the graph view. A line will be drawn showing the 2%
wave runup elevation. A window similar to the one shown below will be displayed.

LINUP - Transect ID: 1 Model: 100y,
File Program Graph Results

" \% _] Aryg. Runup: 2% Runup:
Data | Graph  Refresh| Insert |Remaove 9 2 P

452,465,166, 246 SHAP OFF GRID OFF  |ORTHO OFF | OSMAP OFF

#= 4825 Y= 33
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This plot shows the profile used in the runup analysis in red and the computed runup
elevation (average computed runup depth plus SWEL) as a red dashed line. Click on
the Data button to return to the RUNUP input window

If an area of shallow flooding exists beyond the crest of the dune and the
runup overtops the crest of the dune, an area of shallow flooding should
be identified by designating the area an AO Zone of 1, 2, or 3 foot depth.
Consult the G&S for a more detailed explanation on the application of AO
Zones.

10. Return to main data display
Click on the Data button to return to the RUNUP input table.
If the RUNUP graphic is viewed again the graph will go back to showing the RUNUP

input profile. The Graph Results menu item needs to be selected again to view the
results to the RUNUP model.

11. Exiting RUNUP Program

When the wave runup analysis is complete, close the RUNUP windows by clicking on
the in the upper right corners of each window.

4.6 Program 6: Summary Tables and Graphics for Mapping
1. Summary Table
This program is used to view all of the results from the analysis on the selected

transect. Click on the Summary Table button on the Main Menu Button Bar to open
the window as shown below.

iz Summary Tables - Transect ID: 1 |

¥ Tranzect Input

¥ Convert o Adjusted Tranzect
¥ Erosion Modeling
v '"WHAFIS Madeling

v EBUMUF Modeling

[rata Table: j
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Each phase or program of CHAMP is listed. When a program has been completed, a
check mark will be shown next to that program. Should your modeling effort be
interrupted for some reason, this feature can be used to keep track of all completed
analyses and track the remaining analyses to be completed for each transect.

To view the input and output and all of the results in tabular and text format, click on
the Data Table drop-down menu. Click on a table to view it. The following tables are
available for viewing:

e Transect

e Adjusted Transect

e FEroded Transect

e WHAFIS

e WHAFIS Parts 1, 2, 3, 4, 5, and 6

e STILLWATER

e  WHAFIS Input File

e  WHAFIS Output File

e RUNUP

e RUNUP Output

e RUNUP Input File

e RUNUP Output File

e RUNUP Zone
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2.  Summary Graphics

To view all of the analyses results in graphical format, click on the button on
the Main Menu Button Bar. The window below will open.

# Summary Graphics - Transect 1D: 1

File Edit “iew Draw Format  Modify

B2 o] S alsaleaia]a]

Legena

I:Iiwum_m-
ars Nl

#= 209 Y= 476 C:hexampleshmork shop' 1. dsf

This plot displays all of the results from each program within CHAMP. Each feature
can be turned off or on by selecting the Layers item under the Format menu. The
graphic can be printed by clicking on the Print menu item under the File menu.

Two options available in the summary graphic important to displaying the results are
drawing the PFD Limits and the Legend. Both features can be drawn by selecting the
commands from the Draw menu.
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By selecting the draw PFD Limits item a horizontal zone bar is draw representing the
minimum landward extent of the V-Zone. The PFD has to be identified in the Edit
Transect module before the PFD limit can be drawn.

Selecting the Legend item in the Draw menu draws the legend on the right side of the
grid. The features in the legend will match the features that are turned on in the
layers. If layers are turned on or off or colors and line types are changed, the legend
needs to be redrawn so that the changes are represented. Selecting the Legend menu
item again redraws the legend. The legend can be moved as one piece anywhere
desired by using the Move item under the Modify menu.

From the Summary program, the results can be evaluated, and if one of the analysis
programs needs to be revised or re-run, it can be accomplished by selecting the
appropriate program and repeating the steps described above.

When satisfied with the final results for a transect, the process is repeated for the next
transect until the total project is complete.

4.7 Graphic Controls

The graphics are CADD like in function, and many of the commands work in the same
way. The graphics for CHAMP are stored in one file for each transect with a DXF
extension. Each time a graphic is displayed and results are generated, the information
is saved in the one DXF file for that transect. Four options available to all graphic
displays are Setup, View, Layers, and Print.

1. Setup

Under the Graph menu, click the Setup item to bring up the following window. On the
Summary Graphic, Setup is located under the View menu.

MEraph Setup |
' Scale: IEU—
rir: (270 ' mnir: -35
Hnas: 3600 Ina: 27
¥ Intersal: 500 Y Irterval: |10
Cancel Ok,

This window is used to set the scale and grid for the graphical display. The Y Scale
field is used to stretch or shrink the vertical Y axis. The Xmax and Xmin fields set the
maximum and minimum stations of the grid. The Ymax and Ymin fields set the
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maximum and minimum elevations of the grid. The X Interval and Y interval fields set
the intervals that the grid lines are displayed.

2. View

To access the View menu either right click or select the View item under the Graph
menu. On the Summary Graphic, the View menu has more options than other
graphs. There are five zoom commands available.

Zoom Window: This option lets the user draw a box around an area to be
zoomed in upon.

Zoom In: Zooms one interval closer to center.
Zoom Out: Zooms out one interval further from center.
Full Extent: Fits all within screen window.

Pan: Lets the user drag the screen to re-center the view. Panning can also be
accomplished by using the horizontal and vertical slide bars.

3. Layers

Layers are used to turn on or off different features to be displayed on the graph. Line
types and colors of features can also be changed here. The names of the layers
correspond to a particular feature; for instance, SWEL100 corresponds to the 1%
annual chance SWEL line. The Layers window is accessed by clicking the Layers item
under the Graph menu. In the Summary Graphic, Layers is located under the
Format menu.

To turn a feature off, select the feature and click the button. The feature must
not be the current layer; otherwise, the layer will not Freeze. To change the current
layer, select a layer and click the button. To turn a feature on, select the
feature and click the button. To change the color of a feature, click the
button and a window will be displayed with the color options. To change the line type,
click the button and a list of available line types will be displayed.

Below is an example of what the layer window looks like. All of the possible layers that
can be created are also listed here.

Note: The graphics have to be created first before the layers are created.
Going through each program and viewing the graphs or graph results
creates the layers. Example: The PEAK layer will not be created until
the peak is selected in the Erosion program and the ERODED_LN layer
will not be created until the erosion analysis is completed.
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4. Print

The Print command can be found under the File menu for all graphs. Once selected, a

window, as shown below, will appear.
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From here, the printing options can be set. For the best print follow the steps below:

5.

a. Select the print area by clicking on the button and then drawing a box
around the area to be printed.

b. Select .

c. Select the |Select Printeﬂ button to setup the printer. In the print window,
select properties|, where the user can change the paper size and orientation.
The Orientation option on the Print window is not operational for Version 1.0 of
CHAMP. For best results, it is suggested that the orientation be landscape and
the paper size “11 X 17” if available.

d. Select the [Update View| button to update the print preview with the new
settings to make sure the plot looks as desired.

e. Select the button to send the plot to the printer.

Summary Graphic Options

There are more drawing and editing options available in the Summary Graphic
program than for graphics associated with the other programs. These options include:

Draw menu: There are several items available under the draw menu to add
lines and text to the graphic. One can also draw a leader line, which is an
arrow pointer. The options to draw the PFD Limits and Legend are also here, as
discussed earlier. All new drawn objects will be placed into a layer called
“Others.”

Format menu: Here the user can change the layer options, text style, active
properties, and the properties of any selected object.
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e Modify menu: Options to delete, move, and edit text can be found here. To
delete objects, first select the object and then click on the Delete item in the
Modify menu. The Delete key on the keyboard can also be used instead of using
the menu item.

To move an object, first click on the Move item in the Modify menu and then left
click to select the objects to be moved; next right click to finish selecting objects
and then select the base point to move the objects by left clicking on the base
point. Finally drag the object to the desired location and left click to move the
object.

To edit text select the Text item under the Modify menu and then select the text
to be modified. Here the user can change the text size and justification as well
as edit the text.

Any changes or modification to the graphic can be undone by selecting the Undo item
under the Edit menu. A change or modification can be brought back after undoing by
selecting the Redo item under the Edit menu.

4.8 Help Menu

The help menu is located on the main window. Three electronic documents available
for assistance with CHAMP include this user’s manual, the G&S, and a WHAFIS 4.0
help document. All documents are in .pdf format. Adobe Acrobat Reader must be
installed to view these documents.
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